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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-
ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO 
NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN 
THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 
DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A 
REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and 
conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 
computer. You may physically transfer the SOFTWARE from one computer to another 
provided that the SOFTWARE is used on only one computer at a time. You shall not install 
or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other 
hardware configuration where the SOFTWARE is accessible to more than one CPU or to 
more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE 
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING 
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE 
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, 
or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your 
computer and retain the original for back-up purposes. Any other copying of the 
SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright 
notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support 
for use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions 
or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS 
LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-
ROM storing the SOFTWARE is warranted only against defective material under normal use 
for a period of ninety (90) days after purchase from an authorized Canon dealer as 
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be 
replacement of the same without charge when returned by you at your expense to your 
point of purchase and proven to be defective upon inspection. The replacement CD-ROM 
will be warranted for the remainder of the original ninety (90) day warranty period of the 
defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM 
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to 
anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT 
LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING 
LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR 
ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect 
until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You 
may terminate this Agreement by destroying the SOFTWARE. This Agreement will also 
terminate without notice to you if you fail to comply with any of the terms of this Agreement 
and you must then promptly return the SOFTWARE. In addition, Canon may enforce its 
other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer 
Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the 
Software in the United States of America shall be governed and construed in all respects in 
accordance with the laws and regulations of the State of New York, without reference to 
choice of law principles. The terms of this Agreement as it relates to purchases of the 
Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use 
of the SOFTWARE is subject to the United States, Canada and other applicable copyright 
and trademark laws and nothing in this Agreement constitutes a waiver of the rights of 
Canon, its affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in 
any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND 
CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL 
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER 
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER 
HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS 
SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Introduction

This chapter includes information on the precautions to be read before using 

ZoomBrowser EX, how to use this Instruction Manual, the system 

requirements and the supported image types. It also explains the software 

main features and configuration.

Click on the item to display its page.

About This Manual ............................................................................................................  0-1

System Requirements.......................................................................................................  0-1

Supported Images .............................................................................................................  0-1

How to Use This Instruction Manual................................................................................  0-2

Software Main Features and Configuration ....................................................................  0-3

About This Manual
Thank you for purchasing this Canon product.
Precautions for using this product safely and icons to help you with procedures, etc. are 
described at the beginning of this Instruction Manual. Please be sure to read these first before 
proceeding to the information in the other chapters.

It is prohibited to reproduce, in whole or part, the contents of this Instruction Manual 
without permission.
Canon may change without notice the software specifications and contents of this 
Instruction Manual.
The software screens and displays printed in this Instruction Manual may differ slightly 
from the actual software.
The content of this Instruction Manual has been reviewed thoroughly. However, if you 
should notice any errors or omissions, please contact a Canon Service Center.
Please note that irrespective of the above-mentioned, Canon does not take responsibility 
for the outcome of the operation of the software.

IBM is a registered trademark of International Business Machines Corporation.
Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in 
the United States and/or other countries.
Other names and products not mentioned above may be registered trademarks or 
trademarks of their respective companies.

Trademark Acknowledgments

System Requirements

This software supports the following image types.

OS
Windows XP (Professional/Home Edition), Windows Me, 
Windows 2000, Windows 98SE

Computer
Computer with one of the above OS preinstalled
* Upgraded machines not supported.

CPU 500MHz Pentium or higher

RAM
Windows XP, Windows 2000 Minimum 256MB

Windows Me, Windows 98SE Minimum 128MB

Display
Screen resolution: 1024 x 768 pixels or more
Color quality: Medium (16 bit) or more

Image type/ Camera used Extension

JPEG images Exif 2.2 or 2.21-compatible JPEG images .JPG, .JPEG

RAW images

EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark II, 
EOS 5D, EOS 30D, EOS 20D, EOS DIGITAL REBEL XTi/
400D DIGITAL or EOS DIGITAL REBEL XT/350D DIGITAL

.CR2

EOS-1Ds, EOS-1D .TIF

EOS 10D, EOS DIGITAL REBEL/300D DIGITAL, EOS D60 
or EOS D30

.CRW

BMP images Bitmap images .BMP

TIFF images Exif-compatible TIFF images .TIF, .TIFF

PCD images Photo CD images .PCD

Supported Images
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How to Use This Instruction Manual
Click to move to the 
beginning of each chapter.

:Marks information that should be read before use to prevent 
problems that would interfere with the functioning of software and 
computer.

:Marks additional information that you will find helpful.

Reference page numbers are indicated in blue either in brackets ( ) or 
within text. Click on the page number to move to the corresponding page.

Click to move to the previous page.

Square brackets [ ] are used to indicate items such as menu names, button names 
and window names that appear on the computer screen.

Click to move to the next page.

Click to return to previously displayed page.

In this manual, Windows XP Professional/Home Edition is referred to as “Windows XP”, 
Windows Millennium Edition is referred to as “Windows Me”, Windows 2000 
Professional is referred to as “Windows 2000”, and Windows 98 Second Edition is 
referred to as “Windows 98SE”.

For how to use the software applications, also refer to the Help for each software 
application.

For more information on the restrictions of each software, refer also to the “Readme” file 
for each software application.

Readme: Click the [Start] button  select [All Programs] ([Programs] in versions other 
than Windows XP)  [Canon Utilities]  folder of each software application  

“Readme” file of each software application.

The camera name is shown in the screens as “EOS XXX”.

In this manual, the screens used in the examples are from Windows XP.
Text inside < > in this document indicates the keys on the keyboard and camera button 
names.

 in this document indicates the sequence of operation as 
shown on the right.
Example: [View] menu  [Show Information]  [File Name].
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Software Main Features and Configuration
Canon Digital Camera software having the following features and functions is stored on the EOS DIGITAL Solution Disk. 
Operation is done as shown on this page together with each software application, centered around ZoomBrowser EX.

: Shows the shot image flow.  : Shows software windows and descriptions of operation explained in this manual.

: Shows the interaction between the camera and the software, or between the different software.  : Shows the EOS Utility window and description of operation.

 

EOS Utility (Software for the Camera)

By communicating with the camera, you 
can download to your computer images 
saved in your camera’s memory card, 
perform various camera settings, and 
shoot remotely (p.1-3).
For detailed instructions on EOS Utility, 
refer to the “EOS Utility Instruction 
Manual”.

With the high image quality 
processing and the camera-faithful 
algorithm of Canon’s genuine 
software, you can process RAW 
images in the same colors as the 
camera (p.2-2 to p.2-4).

ZoomBrowser EX (Image Viewing and Editing Software)

Software recommended if 
you mainly shoot JPEG 
images and can perform a 
standard workflow 
(procedure) of downloading, 
viewing, editing, and printing 
images.

You can display and view 3 types of image lists, display an 
individual image in enlarged view, or display images as a 
slide show (p.1-4 to p.1-8).
Images can be easily sorted and classified by single-
operation renaming of multiple files or with the image 
organize function (p.1-9 to p.1-10).
JPEG images can be edited and then converted or saved 
using various functions (p.2-1).
Images can be exported using various functions (p.2-5 to 
p.2-7).
You can print one image on one sheet of paper or print an 
index of multiple images (p.3-1 to p.3-2).
You can attach an image to an e-mail and send it (p.4-1).

ZoomBrowser EX is compatible with Color Management 
System and 2 types of color space (sRGB, Adobe RGB).

RAW Image Task (RAW Image Processing Software) PhotoStitch (Image Merging Software)

You can merge JPEG 
images selected in 
ZoomBrowser EX to 
create panorama images 
(p.2-2).

You can process and display RAW images selected in 
ZoomBrowser EX and set the same processing 
parameters as the camera or change the conditions. 
Also, there is hardly any image deterioration after 
changing the processing parameters.
You can convert or save a RAW image as a JPEG or 
TIFF image, and attach an ICC profile.
With the image transfer function, you can perform image 
editing using third-party image editing software.
RAW Image Task is compatible with Color Management 
System and 2 types of color space (sRGB, Adobe RGB).

Camera settings
Remote shooting

Select JPEG images and merge (p.2-2)Select RAW image and process (p.2-2)

Print image (p.3-1)

Transfer downloaded 
image (p.1-3)

Download image
(p.1-3)

Interaction with 
EOS Utility
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Viewing and Classifying Images

This chapter explains downloading of shot images using EOS Utility, and 

also about displayed images, classifying downloaded images, and other 

topics.

Click on the item to display its page.

Starting up ZoomBrowser EX ..........................................................................  1-1

Downloading Images from Your Camera ........................................................  1-3

Displaying Images.............................................................................................  1-3

Handling the Folders.........................................................................................  1-3

Registering Frequent Use Folder....................................................................  1-3

Selecting the Image Display Mode ..................................................................  1-4

Zoom Mode.....................................................................................................  1-4

Scroll Mode.....................................................................................................  1-5

Preview Mode .................................................................................................  1-6

Viewer Window ...............................................................................................  1-7

Properties Window..........................................................................................  1-8

View & Classify Function..................................................................................  1-8

Viewing the Images as a Slide Show..............................................................  1-8

Renaming the Files in a Single Operation ......................................................  1-9

Classifying the Images into Folders ..............................................................  1-10

Searching Images.........................................................................................  1-10

Starting up ZoomBrowser EX

Double-click on the [ZoomBrowser EX] icon on the desktop.

ZoomBrowser EX starts up and the main 
window is displayed.

Alternatively, you can start up the 
ZoomBrowser EX by clicking the [Start] 

button  select [All Programs] ([Programs] 
in versions other than Windows XP)  
[Canon Utilities]  [ZoomBrowser EX]  

[ZoomBrowser EX].

To exit the ZoomBrowser EX, select the 
[File] menu  [Exit].
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Main Window

When sound is recorded in an image shot with an EOS-1D series camera, [ ] is 
displayed. For playback of the sound, select the [Edit] menu  [Play Sound].

[ ] is displayed on images shot with AEB.

The mark attached to the folder containing the images downloaded with EOS Utility or 
CameraWindow MC is stored until you exit ZoomBrowser EX.

ZoomBrowser EX is compatible with Color Management System (compatible color 
spaces: sRGB, Adobe RGB). When the [Adjust color of images using monitor profile] 
checkbox in the [Color Management] in the preferences (p.4-2) is checkmarked, 
sRGB and Adobe RGB images are displayed in the same colors.

Task buttons
You can perform various operations from 
these buttons (p.1-8 to p.4-2).

Click to show/hide the task buttons.

Folder area
The images in the selected folder are displayed in 
the image display area.
[ ] is attached to the folder containing the 
images downloaded with EOS Utility or 
CameraWindow MC. The shooting date appears 
for the folder name.

Displays the drives and folders on the 
computer (p.1-3).

Add/Remove to Favorites buttons (p.1-3)

Displays the registered favorite folders (p.1-3).

Menu bar
Contains the same functions as the task 
button functions.

Displays the path of the folder selected in the folder area.

Displays the number of images selected.

You can change the display mode of 
the image display area (p.1-4 to p.1-6).

Image display area
The images inside the folder selected in 
the folder area are displayed.

Displayed on images that are protected.

Displayed on RAW images.

Displays the selected image in the viewer window (p.1-7).

Displays the selected image in the properties window (p.1-8).

Displays the selected images as a slide show (automatic playback) (p.1-8).

You can search for images by condition (p.1-10).

You can delete the selected image or folder.

You can rotate the selected image.

Operating buttons

You can switch between showing and hiding the task buttons and folder area.



1-3

1
2
3
4

Cover/Table of
 Contents

Introduction

Viewing and 
Classifying Images

Editing and 
Exporting Images

Printing Images

Troubleshooting

Index

Internet Function 
and Specifying 
Preferences

Downloading Images from Your Camera
You can download shot images saved on the CF card in your camera to your computer using 
EOS Utility, software for the camera.
For detailed instructions on EOS Utility, refer to the “EOS Utility Instruction Manual”.

The images in the folder selected in the folder area are displayed in the image display area.

1 Start up ZoomBrowser EX (p.1-1).

2 Click [Acquire & Camera Settings].

[Acquire & Camera Settings] menu 

appears.

3 Click [Connect to EOS Camera].

[EOS Utility] starts up.

4 Connect the camera to your computer with the interface cable and 
set the camera’s power switch to <ON>.

5 Click the [Starts to download images] button in [EOS Utility].

The images are downloaded to the computer and the downloaded images are 
displayed in the ZoomBrowser EX main window. 

When downloading images using a third-party card reader, insert the memory card 
removed from the camera in the card reader, and click [Acquire Images from Memory 
Card] in step 3. The image download window appears. You can then download images 
by clicking the [Starts to download images] button. For detailed information on 
downloading images using a third-party card reader, refer to “Downloading Images Using 
Your Card reader” in the “EOS Utility Instruction Manual”.

Select the folder where the 
images to be displayed are saved.

The images in the folder are displayed in 
the main window.

Displaying Images

Handling the Folders
You can handle the folder from the menu that appears by clicking the folder with the right button 
on the mouse.

You can register a frequently used folder as a [Favorite Folders].

Click on the folder with the right button on the mouse and select 
an option from the menu that appears.

1 Select the [All Folders] tab.

2 Select the folder you want to 
register and then click the [Add to 
Favorites] button.

The folder is displayed as [ ]

3 Select the [Favorite Folders] tab.

The registered folder appears.

Alternatively, you can register a favorite 
folder in the dialog box displayed when 
you click the [Add] button in the [Favorite 

Folders] tab sheet.

To remove the registered folder, click the 
[Remove] button in the [Favorite Folders] 
tab sheet.

The removed registered folder is deleted only from the [Favorite Folders] tab sheet and 
the actual folder or images inside the folder are not deleted.

Registering Frequent Use Folder
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Selecting the Image Display Mode
You can select the image display mode from 3 types (Zoom Mode, Scroll Mode and Preview 
Mode).
Also, in the viewer window, you can display images individually, and in the properties window, 
you can check shooting information and enter comments, etc.

You can zoom into the target folder and display the images inside the folder.

Select the [Zoom Mode] tab.

To select an image, click the target image.
If you double-click an image, the image will be displayed in the viewer window (p.1-7).
To select sequential images, click the first image and then hold down the <Shift> key and 
click the last image.

To select multiple images, hold down the <Ctrl> key and click the images.
If you move the cursor over the image and wait for a while, the image will be displayed 
individually.
You can zoom in by double-clicking inside the folder frame.

You can set the zoom speed when a folder is selected (p.4-2).

Zoom Mode

Returns to the display of the folder 
previously displayed.

Returns to the display of the folder 
before [ ] is clicked.

Displays the folder one level above.

You can select or deselect all the images and folders. You can set the information to be displayed for the images.

Displays the image enlarged.
When the image is enlarged, the [Navigator] window 
appears and you can check the enlarged display 
position and move it by dragging.

Displays the image reduced.

Drag left or right to display the image enlarged or 
reduced.

You can further select images to be displayed according 
to a “Rating”.

To select an image after enlarging or reducing it, 
click this button before selecting it.

Zoom Mode tab

Folder area
The images in the selected folder are displayed 
in the image display area.

Displays the image to fit the size of the window.

Image display area
The images inside the folder selected in 
the folder area are displayed.

When the image is displayed as an enlargement, you can move the 
display position by dragging the image.Operating buttons (p.1-2)
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You can display the images in multiple folders at the same time.

Select the [Scroll Mode] tab.

To select an image, click the target image.
If you double-click an image, the image will be displayed in the viewer window (p.1-7).
To select sequential images, click the first image and then hold down the <Shift> key and 
click the last image.

To select multiple images, hold down the <Ctrl> key and click the images.
If you move the cursor over the image and wait for a while, the image will be displayed 
individually.

You can set the level of the folder that displays the images (p.4-2).

Scroll Mode

Returns to the display of the folder previously displayed.

Returns to the display of the folder before [ ] is clicked.
Displays the folder one level above.

You can select or deselect all the images and folders.
You can set the information to be displayed for the images.

Drag left or right to display the image enlarged 
or reduced.

You can further select images to be displayed 
according to a “Rating”.

Scroll Mode tab

Folder area
The images or folders in the selected folder are 
displayed in the image display area.

Image display area
The images or folders inside the folder 
selected in the folder area are displayed.

Operating buttons (p.1-2)
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You can select an image displayed as a thumbnail and display it individually.

Select the [Preview Mode] tab.

To select multiple images, hold down the <Ctrl> key and click the images.
To select sequential images, click the first image and then hold down the <Shift> key and 
click the last image.
You can switch between showing and hiding each item by clicking the [ ] button in the 
image information area.

If you move the cursor over the thumbnail image and wait for a while, the image will be 
displayed individually.

If you double-click on a folder in the thumbnail image display area, the images inside the 
folder will be displayed.

You cannot change the file name or edit an image that is protected.

Preview Mode

Returns to the display of the folder previously displayed.

Returns to the display of the folder before [ ] is clicked. Displays the folder one level above.

You can select or deselect all the images and folders.

You can set the information to be displayed for the images.

You can further select images to be displayed according to a “Rating”.

You can change the file name.

You can set a “Rating”.

You can set protection.

You can enter comments.
The [View/Modify Keywords] dialog box appears 
and you can set a keyword.

Displays the histogram (brightness 
distribution).

Displays the shooting information.

Thumbnail image display area
The images inside the folder selected in the folder 
area are displayed.
If you click an image, the image will be displayed in 
the image display area.
If you double-click an image, the image will be 
displayed in the viewer window (p.1-7).

Image display area
The image selected in the thumbnail image 
display area is displayed.

Preview Mode tab

Folder area
The images in the selected folder are displayed 
in the thumbnail image display area.

When a sound file is selected, the information of the 
sound file is displayed. If the [Play Sound] button is 
clicked, the sound is played back.

You can show/hide the image information area.

Displays the previous image.

Displays the next image.

Image information area

Operating buttons (p.1-2)
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You can display images in individual windows.

Double-click the image.
The selected image is displayed in the viewer window.

Viewer Window

Displays the next image.*

Displays the previous image.*

You can divide the window and display 
multiple images.*

When you have divided the window and 
displayed multiple images, you can link the 
images by making the enlargement ratio and 
display position of the images the same.*

Displays the image enlarged.
When the image is enlarged, the [Navigator] window appears 
and you can check the enlarged display position and move it by 
dragging.

Displays the image reduced.

Drag left or right to display the image enlarged 
or reduced.

When the image is displayed as an enlargement, you can move the display position by dragging 
the image.

Displays the image to fit the size of the window.

You can edit the image (p.2-1).

You can set a “Rating”.

You can display the AF point used when the shot was taken.

You can display the image in full screen.
To return to the original view, click the image.

Only displayed on RAW images.
You can process a RAW image and display it.

You can print the image (p.3-1).

You can display the shooting information.

* When you have selected multiple images and opened the viewer window, you can switch between the 
selected images. If you have selected one image and opened the viewer window, you can switch 
between images inside the same folder.

When the shot was taken with automatic AF point selection, multiple active AF points 
might be displayed.
You can change the processing parameters of RAW images (p.2-2).
You can set the items that are displayed as the shooting information (p.4-2).

You can set the image to 100% view 
(actual pixel size).

If RAW images are not processed, they cannot be displayed enlarged or reduced. To 
display RAW images enlarged or reduced, first click the [Display Original Image] button 
and process the images. 
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You can enter information and comments for the images.

1 Select the image in zoom mode (p.1-4) or scroll mode (p.1-5).

2 Click the [Properties] button (p.1-2).

The properties window appears.

* When you select multiple images and open the properties window, you can switch the image 
displayed.

You can switch between showing and hiding each item by clicking the [ ] button.

You cannot change the file name or edit an image that is protected.

If you select a sound file, the information relating to that sound file is displayed.

Properties Window

You can change the file 
name.You can set a “Rating”.

You can set protection.

You can enter comments.

Displays the shooting 
information.

Displays the histogram 
(brightness distribution).

The [View/Modify 
Keywords] dialog box is 
displayed and you can set 
a keyword.

Displays the viewer window 
(p.1-7).

Displays the Help.

Displays the previous image.*

Displays the next image.*

View & Classify Function

You can view the images as a slide show (automatic playback).

1 Select the images.

2 Click [View & Classify].

The [View & Classify] menu appears.

3 Click [View as a Slide Show].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Start Slide Show].

The slide show begins.

Viewing the Images as a Slide Show
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You can set a “Rating”.

If clicked when an image is displayed, 
the image appears selected or 
deselected in the main window after 
the slide show ends.

If clicked when an image is displayed, 
the printing dialog box (p.3-1) appears 
after the slide show ends, and you can 
print the selected images.

Displays the previous image.

Pauses the slide show.

Displays the next image.

Ends the slide show.

You can rename the multiple files in a single operation.

1 Select the images.

2 Click [View & Classify].

The [View & Classify] menu appears.

3 Click [Rename Multiple Files].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Finish].

The processing window appears and the 

settings are executed.

Renaming the Files in a Single Operation
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You can classify images according to the date and time they were shot.

1 Select the images.

2 Click [View & Classify].

The [View & Classify] menu appears.

3 Click [Classify into Folder].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Finish].

The processing window appears and the 

settings are executed.

Classifying the Images into Folders
You can search for images with set conditions.

1 Select in the folder area or in the image display area the folder or 
drive to be searched (p.1-2).

2 Click [View & Classify].

The [View & Classify] menu appears.

3 Click [Search].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Start Search].

The search begins and the images that match the set conditions are displayed.

6 Click [Finish].

The display returns to the main window.

Select the [Search Results] folder in the folder area to display the searched images.

The images in the [Search Results] folder are stored until you search for an image 
with set conditions again or exit ZoomBrowser EX.

All operations performed on images in the [Search Results] folder are reflected in any 
original images. Please be cautioned that editing or deleting of images in the [Search 
Results] folder will then also cause editing or deleting of any original images.

Searching Images
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Editing and Exporting Images

This chapter explains image editing, processing RAW images and various 

ways to export images.

Click on the item to display its page.

Editing Function ................................................................................................  2-1

Editing Images ................................................................................................  2-1

Merging Images ..............................................................................................  2-2

Processing RAW Images................................................................................  2-2

Exporting Function ...........................................................................................  2-5

Exporting Images............................................................................................  2-5

Exporting Shooting Properties ........................................................................  2-5

Exporting an Image as a Screen Saver ..........................................................  2-6

Exporting an Image as Wallpaper...................................................................  2-6

Writing Images to a CD...................................................................................  2-7

Editing Function

You can edit your images with red-eye correction, brightness/color correction, sharpness, 
trimming, text insertion, automatic correction. Also, you can transfer an image to other image 
editing software.

1 Select one image.

2 Click [Edit].

The [Edit] menu appears.

Editing Images

3 Click [Edit Image].

The settings window appears.

4 Select the contents to be edited and then click [Finish].

A window for the selected contents to be edited appears.

For detailed information, click the [?] button and refer to the Help displayed.

To transfer and edit your image in different image editing software, select [Edit with 

external image editor], click the [Manage List] button and then select the image 
editing software to be used.

5 Adjust using the window that appears.

6 Click the [Save As] button.

The [Save As] dialog box appears.

7 Select the save destination and click the [Save] button.

The edited image is saved.

You cannot select multiple images and edit.
You cannot edit RAW images here. You can edit RAW images with RAW Image Task. 
By converting RAW images to JPEG or TIFF images, you can edit as described on 
this page (p.2-2).
Edited images cannot be reverted to their original condition. We recommend saving 
edited images under a different name.
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You can merge up to 4 JPEG images to create a panorama image.

1 Select multiple images.

2 Click [Edit].

The [Edit] menu appears.

3 Click [Stitch Photos].

The PhotoStitch starts up and the main 
window is displayed.

Follow the instructions displayed to merge 
the images.

For detailed information, click the [?] 

button and refer to the Help displayed.

You cannot merge RAW images in the PhotoStitch.

Merging may not be successful when more than 4 images are merged.

Merging Images
You can specify the same processing parameters for RAW images as for the camera.

Also, you can convert RAW images to JPEG images or TIFF images and save or transfer them 
to other image editing software, as well as attach ICC profiles.

1 Select the RAW image.

2 Click [Edit].

The [Edit] menu appears.

3 Click [Process RAW Images].

The RAW Image Task starts up and the 
main window is displayed.

Refer to the next page for an explanation 
of the RAW Image Task window.

For detailed information, refer to [Help] 

menu and the [RAW Image Task Help].

4 Adjust the image.

Adjust the image with the [Image Quality Adjustment] window.

5 Click [Save] in the toolbar.

The [Save] window appears.

6 Specify desired settings.

7 Click the [Save] button.

The processing window appears and the image is saved.

8 Select the [File] menu  [Exit].

The RAW Image Task exits.

Processing RAW Images
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RAW Image Task Main Window

* When you have selected multiple RAW images and started RAW Image Task, you can switch between 
the images displayed in the image display area.

Thumbnail image display area
The selected image is processed and displayed 
in the image display area.

Image display area
The image selected in the thumbnail image display area is 
processed and displayed.

Drag left or right to display the image enlarged or 
reduced.

Toolbar

Displays the previous image. *

Displays the next image. *

You can set checkmarks on images selected in the 
thumbnail image display area.

You can transfer the image to the specified image editing software.

You can save the adjusted image.

You can rotate a selected image.

You can select, deselect, etc. all the images.

You can show/hide the [Image Quality Adjustment] window (p.2-4).
Click this button before selecting the image.

Displays the image enlarged.
When the image is enlarged, the [Navigator] window 
appears and you can check the enlarged display 
position and move it by dragging.

Displays the image reduced.

You can show/hide the [Histogram] window.

You can show/hide the [Navigator] window.

You can show/hide the shooting information.

Displays the image to fit the size of the window.

The image is displayed at 100% (actual pixel size).

The zoom ratio of the image is displayed.

When the image is displayed as an enlargement, you can 
move the display position by dragging the image.

Displays the coordinates of the cursor position and 
the RGB values (8-bit conversion) of the image.
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Image Quality Adjustment Window

The above window shows information displayble when you select a RAW image shot with 
the EOS-1D Mark II N, EOS 5D, EOS 30D and EOS DIGITAL REBEL XTi/400D DIGITAL. 
The displayed information varies depending on the camera used to shoot.
The settings at the time of shooting are displayed in bold/italics in the list box of the [Image 
Quality Adjustment] window.
The processing parameters you have set can be applied to other images by copy/paste, 
save/download in the [Development Conditions] menu in the [Edit] menu.
With the EOS-1D series cameras, you can save an adjusted tone curve or white balance as 
a file. Also, you can register the saved files in the camera. For detailed instructions, refer to 
“Setting the EOS-1D Series Cameras” in the “EOS Utility Instruction Manual”.

When checkmarked, the 
specified processing 
parameters are applied 
to the image each time.

Sets each processing parameter.

You can cancel all new settings made and revert to the processing 
parameters of when the image was shot.

The specified processing parameters are applied to the image.

You can load Picture Style files downloaded from 
Canon’s web site and saved on your computer and 
apply them to images.
 (This function is compatible with the EOS-1D Mark II N, 
EOS 5D,  EOS 30D and EOS DIGITAL REBEL XTi/
400D DIGITAL.)

EOS-1D Mark II NEOS 5D, EOS 30D, and EOS 
DIGITAL REBEL XTi/400D DIGITAL

You can save an 
adjusted white balance 
as a white balance file.

White balance files saved in EOS-1D series cameras cannot be used with other camera 
models.

A Picture Style file is a file that expands the Picture Style function. For detailed 
information on Picture Style files, refer to Canon’s web site.
Because only the processing parameter settings are changed and they are not added 
to the RAW image, you can change the parameters multiple times or revert to the 
condition when the image was shot. In addition, there is hardly any of the image 
deterioration that accompanies processing parameter changes.
When the [Preview] checkbox is checkmarked, every time you set a processing 
parameter, the image is processed/redisplayed. To process multiple processing 
parameters in one operation, remove the checkmark from the [Preview]. After setting 
multiple processing parameters, click the [Update] button and the multiple processing 
parameters will be processed/redisplayed in one operation.
The time needed after setting of processing parameters for processing and displaying 
an image is approximately 1 to 3 seconds.
• The above time is only an estimate. Processing times vary widely depending on the 

camera model used to take the RAW image, the type of computer, and the subject of 
the photo. 

• Processing times are based on Canon testing standards. 
(When using the following: OS: Windows XP, CPU: 2.2 GHz Pentium 4; RAM: 512MB)

You can edit JPEG and TIFF images that have been converted and saved from RAW 
images (p.2-1).
You can attach ICC profiles to JPEG and TIFF images converted and saved from 
RAW images. 
An ICC profile contains color information, such as color properties and color spaces 
of devices which are authorized by International Color Consortium (ICC). With this 
ICC profile, many Color Management Systems can minimize the color differences 
between devices.
RAW Image Task is compatible with Color Management System. 
In addition, RAW Image Task is compatible with two types of color space (sRGB, 
Adobe RGB), and if the [Adjust color of images using monitor profile] checkbox in the 
[Color Management] in the preferences of ZoomBrowser EX (p.4-2) is checkmarked, 
sRGB and Adobe RGB images displayed in RAW Image Task are displayed in the 
same color.
sRGB: Windows standard color space. Also widely used for the standard color 

space for monitors, digital cameras, scanners and other devices.
Adobe RGB: A wider color space than sRGB. Mainly used for printing for business 

purposes.
White balance files and tone curve files saved in EOS-1D series cameras are 
compatible with RAW Image Task for both Windows and Macintosh.
Tone curve files for the EOS-1Ds Mark II and EOS-1D Mark II are compatible.
Tone curve files for the EOS-1Ds and EOS-1D are compatible.
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Exporting Function

You can change the size of JPEG images as well as convert them to other image types and 
save them.

1 Select the images.

2 Click [Export].

The [Export] menu appears.

3 Click [Export Still Images].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].

The processing window appears and the settings are executed.

You cannot export RAW images.

Exporting Images
You can export as a text file the shooting properties recorded to the image when the shot was 
taken.

1 Select the image.

2 Click [Export].

The [Export] menu appears.

3 Click [Export Shooting 
Properties].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].

The processing window appears and the settings are executed.

Exporting Shooting Properties



2-6

1
2
3
4

Cover/Table of
 Contents

Introduction

Viewing and 
Classifying Images

Editing and 
Exporting Images

Printing Images

Troubleshooting

Index

Internet Function 
and Specifying 
Preferences

You can export a JPEG image as a file for a computer screen saver.

1 Select the image.

2 Click [Export].

The [Export] menu appears.

3 Click [Export as a Screen Saver].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Finish].

The processing window appears and the settings are executed.

You cannot export RAW images.

Exporting an Image as a Screen Saver
You can export a JPEG image as a file for wallpaper for a computer.

1 Select the image.

2 Click [Export].

The [Export] menu appears.

3 Click [Export as a Wallpaper].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Finish].

The processing window appears and the settings are executed.

You cannot export RAW images.

Exporting an Image as Wallpaper
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You can write images to a CD-R/CD-RW.

This function is only compatible with a computer that has Windows XP pre-installed and is 
equipped with a standard CD-R/CD-RW drive.

1 Select the images.

2 Click [Export].

The [Export] menu appears.

3 Click [Backup to CD].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Start Backup].

The processing window appears and the settings are executed.

Writing Images to a CD
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Printing Images

This chapter explains various ways to print images. Click on the item to display its page.

Printing Images .................................................................................................  3-1

One Photo per Page Printing ..........................................................................  3-1

Index Printing ..................................................................................................  3-1

Printing with Easy-PhotoPrint .........................................................................  3-2

Printing Using Other Software ........................................................................  3-2

Printing Images

You can print one photo per page.

1 Select the image.

2 Click [Print].

The [Print] menu appears.

3 Click [One Photo per Page Print].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Print] button.

The processing window appears and the image is printed.

If Easy-PhotoPrint, the dedicated printing software for Canon PIXMA/BJ Printers, is 
installed, it becomes the default software for printing (p.3-2). To cancel printing with 
Easy-PhotoPrint and switch to printing with ZoomBrowser EX independently, select [Use 
the Print Function in ZoomBrowser EX] in the [Printing] tab sheet of the preferences 
(p.4-2).

One Photo per Page Printing
You can print multiple images in index format.

1 Select the images.

2 Click [Print].

The [Print] menu appears.

3 Click [Index Print].

The settings window appears.

4 Specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click [Print] button.

The processing window appears and the images are printed.

Index Printing
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Easy-PhotoPrint is software exclusively for use with Canon PIXMA/BJ printers. If Easy-
PhotoPrint is installed on your computer, you can print with Easy-PhotoPrint.

1 Select an image.

2 Click [Print].

The [Print] menu appears.

3 Click [Easy-PhotoPrint].

Easy-PhotoPrint starts up.

Follow the instructions displayed to print 

the images.

If Easy-PhotoPrint is not installed, [Easy-PhotoPrint] will not be displayed in the [Print] 
menu.

Printing with Easy-PhotoPrint
You can select software other than ZoomBrowser EX and print.

1 Select an image.

2 Click [Print].

The [Print] menu appears.

3 Click [Print Using Other Software].

The settings window appears.

4 Select the software for printing 
and specify desired settings.

For detailed information, click the [?] 

button and refer to the Help displayed.

5 Click the [Launch Software] button.

The software selected in step 4 starts. Follow the instructions displayed to print the 
images.

If printing software compatible with ZoomBrowser EX is not installed, you will be unable 
to select printing software in step 4 for printing.

Printing Using Other Software
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Internet Function and Specifying Preferences

This chapter explains sending images with your e-mail software and 

specifying preferences for ZoomBrowser EX.

Click on the item to display its page.

Internet Function ...............................................................................................  4-1

Sending an Image by E-mail...........................................................................  4-1

Modifying ZoomBrowser EX Settings .............................................................  4-2

Task Button Display Settings..........................................................................  4-2

Specifying Preferences...................................................................................  4-2

Internet Function

You can attach an image to an e-mail and send it.

1 Select the image.

2 Click [Internet].

The [Internet] menu appears.

3 Click [Email Images].

The settings window for the attached 
image appears. 

4 Specify desired settings.

For detailed information, click the [?] button and refer to the Help displayed.

5 Click the [Send or Save] button.

The settings window for your e-mail software appears. 

6 Specify desired settings.

For detailed information, click the [?] button and refer to the Help displayed.

7 Click [Finish].

Your e-mail software starts up.

Enter the necessary information and then send the message.

Sending an Image by E-mail
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Modifying ZoomBrowser EX Settings

You can specify which task buttons to show or hide.

You can set various ZoomBrowser EX function settings.

1 Select the [Tools] menu  [Customize].

2 Select the items you want to show.

Deselect the items you do not want to show.

1 Select the [Tools] menu  [Preferences].

2 Specify desired settings.

For detailed information, click the [?] button and refer to the Help displayed.

Task Button Display Settings

Specifying Preferences
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Troubleshooting

This chapter provides troubleshooting and explains how to uninstall the 

software.

Click on the item to display its page.

Troubleshooting ................................................................................................  5-1

Uninstalling the Software .................................................................................  5-2

Index ...................................................................................................................  5-2

Troubleshooting
If you could not complete the installation correctly, software does not work, or you could not 
display images with ZoomBrowser EX, consult the items described below.

For instructions on installing, refer to the “Software Guide” supplied with your camera.

Are you using Windows XP under a setting other than [Computer 
administrator] privileges or using Windows 2000 under a setting other than 
[Administrator] privileges?

You cannot install software if a user setting other than [Computer administrator] 
privileges or [Administrator] privileges is selected. Select the [Computer administrator] 
privileges user setting in Windows XP or the [Administrator] privileges user setting in 
Windows 2000. For detailed information on selecting the user setting, refer to your 
computer’s instruction manual.

Does your computer meet the system requirements for the software?
Check the system requirements (p.0-1).

Is there enough RAM (memory)?
Check the system requirements (p.0-1).

Is the screen resolution less than [1024 by 768 pixels]?
Specify [1024 by 768 pixels] or more for the screen resolution (p.0-1).

Is the color quality less than [Medium (16 bit)]?
Specify [Medium (16 bit)] or more for the color quality (p.0-1).

Are multiple applications running?
Exit any applications other than ZoomBrowser EX. Even if your computer has the RAM 
capacity (memory) described in system requirements (p.0-1), if other application is 
running at the same time as ZoomBrowser EX, you may not have sufficient RAM 
(memory).

Did you try to display images other than the image types that are supported 
by ZoomBrowser EX?

Check the supported images (p.0-1).

Installation failed.

Software does not work.

Could not display images with ZoomBrowser EX.
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Uninstalling the Software
The following explanation uses the procedures for uninstalling the ZoomBrowser EX as an 
example for uninstalling other programs as well.

For Windows XP Professional or Windows 2000, log in under [Computer administrator]/
[Administrator] privileges.

Before starting the software uninstallation, exit all programs you are using and disconnect 
the dedicated cable from your computer.

To prevent computer malfunctions, always restart your computer after you have uninstalled 
the software. Re-installing the software without first restarting your computer is likely to 
result in computer malfunctions.

1 Click the [Start] button  select [All Programs] ([Programs] in 
versions other than Windows XP)  [Canon Utilities]  
[ZoomBrowser EX]  [ZoomBrowser EX Uninstall].

2 Proceed with the uninstallation as directed by the on-screen 
messages.

Software is uninstalled.
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